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Chapter 1: Introduction to RiskyProject

What is RiskyProject?
RiskyProject is advanced project risk management software with integrated risk analysis. Most
projects contain many uncertain parameters: task duration, start and finish times, uncertainties in
costs and resources, uncertainties in quality, safety, technology, and others. RiskyProject analyzes
project schedules with risks and uncertainties, calculates the chance that projects will be
completed within a given period of time and budget, ranks risks, and presents the results in
formats that are easy to read and understand.
RiskyProject also helps you to perform project risk management:
•

identify project risks

•

rank risks

•

identify mitigation and response plans

•

manage risk properties, including descriptions, probabilities and impacts, costs associated
with risks, mitigation strategies, and all other information about risks

•

facilitate risk reviews, opening and closing risks, conversion of risks to issues and lessons
learned

•

provide comprehensive risk reporting, save risk history

RiskyProject performs both qualitative and quantitative risk analysis. If both the risk register and
project schedule are populated, RiskyProject performs quantitative risk analysis. If there is no
project data (cost or schedule), RiskyProject performs qualitative risks analysis.
RiskyProject

Microsoft Project, Oracle
Primavera, and other Project
Management software

Project Schedule

Quantitative risk
analysis

Risk Adjusted Project
Schedule

Risk Register

Monte Carlo
Simulations

Qualitative risk
analysis

Ranked Risk and Evaluated
Mitigation/Response Plans

RiskyProject seamlessly integrates with Microsoft Project or can run as a standalone application.
RiskyProject integrates with other project management software such as Oracle Primavera.
RiskyProject employs Event Chain Methodology to analyze project uncertainties defined by
multiple risks (events). An example of an event would be a task delay due to the changes in
requirements. In many cases, one event can cause another event or multiple events, which can
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significantly affect the project schedule. RiskyProject recalculates the project schedule multiple
times to compute the distribution of possible outcomes and probabilities of meeting specific
objectives.

Qualitative vs. Quantitative Risk Analysis
RiskyProject performs both qualitative and quantitative risk analysis.
A typical qualitative risk analysis workflow is used to:
1. Identify risks and add risks to the risk register.
2. Define risk properties, probabilities, and outcomes.
3. Analyze risks and prioritize risks.
4. Assign mitigation and/or response plans.
5. Update risk properties, probabilities, outcomes as necessary.
6. Review status and properties of the risk and report information about risks.
A typical quantitative risk analysis workflow is used to:
1. Create a project schedule.
2. Add risks, uncertainties, and other risk-related information.
3. Run a simulation, perform an analysis and generate a report of the results.
4. Update risks and uncertainties as necessary.
5. During project execution, perform project tracking with risks and uncertainties at key phases
or milestones to update forecasts.
6. Report results
If you do not have a schedule for your project, RiskyProject will only perform qualitative risk
analysis. However, if you add a schedule by either adding activities or importing a schedule,
RiskyProject automatically switches to quantitative analysis. You may switch between qualitative
and quantitative analysis by adding or removing a project schedule.
Adding or removing
project schedule
Qualitative risk
analysis

Quantitative risk
analysis

Due to the nature of qualitative and quantitative analysis the results can be different even with the
same risks, particularly for schedule-related risks affecting project duration and cost.

Chapter 2: Qualitative Risk Analysis

Risks in RiskyProject
Risk Register
The Risk Register is a set of all the project risks. You can enter risks in either the Risk Register
view:
Click Risk Register
to view risk register
Filter risks based
on their properties

View risks hierarchy based on
the different parameters,
categories, owner, manager,
open/closed, etc.

By default, risks are ranked based
on their scores. You can rank
risks based on content of each
column

Sort risks
alphabetically or on
risk ID

Click Risk Register
to view risk register

You can create
multiple tabs (views)
for Risk Register

Each tab presents
different views of Risk
register

Use the Risk Register to:
1. View risks with their attributes such as probabilities, impacts, scores, and properties.
2. Create a risk register hierarchy based on:
•

Risk categories
•
Open/Closed risks
•
Risk/Issues/Lessons Learned
•
Risks assigned to managers
•
Risks assigned to owners
•
Threat mitigation or opportunity mitigation strategies
•
Assigned/Unassigned Risks (active or inactive)
•
Hidden and Visible risks (available in RiskyProject Enterprise only, see RiskyProject
Enterprise User Guide)
3. Rank risks based on risk score.
4. Sort risks alphabetically or using risk IDs.
5. Filter risks based on risk properties: Open, Closed, Risk, Issue, or Lessons Learned.
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Data for the Risk Register can be subdivided into three categories: risk registry, risk
mitigation/response plans, and settings:
Risk Register
Risk 1 with attributes:
General
Information

Risk cost

Probabilities
and impacts

Risk history

Risk reviews

Custom
properties

Mitigation /
response plan
assignments

Risk 2 with attributes
Risk 3 with attributes
…………………

Mitigation or response plans
Plan 1 with attributes

Plan 2 with attributes
……..

Risk Register Settings

Risk Categories
and Outcomes

Default Risk
Properties

Risk Matrix
settings

Risk ID
generation rules

About Risk Categories, Probabilities and Impacts
Risk Categories
Risk Categories are a group of risk outcomes. RiskyProject calculates risk probabilities, impacts
and scores for each category. The default risk categories are:

•

Duration
•
Cost
•
Safety
•
Environment
•
Legal
•
Performance
•
Technology
RiskyProject calculates the score and rank for all risks in each risk category. You can view risk
scores and rankings for each risk category or for all categories.
In the Risk Register, Risk Matrix, and Risk Report you can view
risks associated with a specific risk category

You can customize the risk categories in the Risk Categories dialog box. For more information
about customizing risk categories, read “Managing Risk Categories and Outcomes”.

Risk Outcome Types
A Risk Outcome Type is the result if a risk occurs. While every risk category must have a least
one outcome, they can have several. For example, one of the default risk categories is Legal. You
may want to further define the outcome types as Litigation Risk, International Legal Risk, etc.
You can customize the set of outcome types using the Risk Categories dialog box.

Risk Probability and Chance
Risk Probability is the calculated chance that an event will occur. You can view risk probability
in the Risk Matrix, Risk Register, and other views and dialog boxes. Risk Chance is the input
parameter for risk probability. Risk chance (input parameter) and risk probability (calculated
attribute) can be different; particularly when a risk has multiple mutually exclusive alternatives as
risk, chance is an input parameter for each alternative. In these cases, Risk probability is
calculated based on the risk chance for each mutually exclusive alternative.

Risk Outcome
Risk Outcomes indicate the severity of a risk event for the specific risk category. You need to
enter risk outcomes when you define risk chance and outcome type. For example, here are the
default risk outcomes for the risk category Schedule:
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Default list of risk outcomes can be customized in
Format Risk Matrix dialog.

Outcome types can be a label (e.g. Critical > 1 year delay) or a percentage (e.g. 5%), or a
combination of both. You can set how you want to enter and view risk outcomes in the Format
Risk Matrix dialog box. Each label is associated with percentage, which is the midpoint of the
interval for each label:
Label

Interval

Midpoint

Negligible: < 1 month delay

From 0% to 20%

10%

Minor: 1-3 month delay

From 20% to 40%

30%

Moderate: 3-6 months delay

From 40% to 60%

50%

Serious: 6-12 months delay

From 60% to 80%

70%

Critical: > 1 year delay

From 80% to 100%

90%

When you define outcome types as a percentage, you can enter it as any number from 0% to
100%. In this scenario, it will be associated with a label based on the interval to which this
percentage belongs. For example, 76%, corresponds with the “Serious: 6-12 months delay”
outcome type.
In RiskyProject, risk outcome types can be probabilistic. You can define a statistical distribution for
outcome types and perform Monte Carlo simulation even it is part of qualitative risk analysis. For more
information about probabilistic risk outcome types, read “Uncertainties in Risk Outcomes”.

The diagram below shows the relationship between risk categories, risk outcome types, and risk
outcomes.
Risk Category
Duration
Cost
Legal
…..

Risk Outcome Type
Litigation Risk

Risk Outcome

International Legal
Risk
…..

Expressed as labels

Expressed as a
Percent

Very low
Low
Medium
High

75 %

Threats and Opportunities
Risks can be threats, opportunities or both. Threats and opportunities are defined for risk
assignment depending on results of the risk outcome. Negative risk outcomes mean opportunities.
Example 1:
risk: Change Requirements
Outcome: Fixed Delay
Result: 2 days
This is a threat
Example 2:
risk: Change of technology
Outcome: Delay in technology introduction
Result: -10% Low
This is an opportunity: a negative number indicates that this is acceleration rather than a
delay of the technology introduction
Example 3:
risk: Chance of supplier
Outcome: fixed cost increase
Result for mutually exclusive alternative 1: $30,000
Result for mutually exclusive alternative 2: -$20,000
This is both a threat and an opportunity depending upon the supplier.
You can have different sets of labels for threats and opportunities for a risk category. For
example, for the risk category Schedule, a threat outcome type can be “Critical > 1 year delay”,
for an opportunity it can be “Critical > 1 year acceleration”. If you want to enter opportunities,
you need to enter a negative percentage (e.g. -25%) as the outcome type.

Risk Impact
Risk impact is the calculated result of the risk event. Risk outcome (input parameter) and risk
impact (calculated attribute) can be different, particularly when a risk has multiple mutually
exclusive alternatives, in which case the risk outcome is a parameter of each alternative. Risk
impact is calculated based on the risk chance for each alternative.
The diagram below shows the difference between risk chances and outcomes (input parameters)
and risk probabilities and impacts (output parameters):
Risk 1 has multiple outcomes: for different categories and different mutually exclusive alternatives
Outcome

Chance

Safety – 70%

Safety – 30%

Schedule – 50%

Schedule – 30%

Cost – 50%

Cost – 30%

Calcu
lation

Integrated probability and impact for
all parameters
Impact - 70%

Probability – 30%
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Risk Score
Risk score is a calculated parameter that equals probability multiplied by impact. Risk score is
calculated for each risk category as well as all risk categories.

Original, Pre-, and Post-Mitigation Probabilities, Impacts and Scores
RiskyProject calculates three sets of probabilities, impacts and scores for each risk category as
well as combined for all categories. You can view these sets in the Risk Register, Mitigation
Assignment View, and Mitigation tab of Risk Information Dialog.
1. Original: when risk chance and outcome are defined. This information can be entered in the
list of risk mitigation plans in Mitigation tab of Risk Information Dialog. Original chance,
outcome and scores can be shown in the Risk Register as read-only. RiskyProject can only
save one set of original chance, impact, and score per risk.
Risk Register

Add Column for Original
Chance, Impact or Score.
They will be Read Only
in Risk Register. These
columns are hidden by
default.

Right click on column’s
header to insert new or
modify existing column.

Mitigation Tab of Risk
Information dialog

You can designate any
set of chance, impact and
score as Original.

Enter risk chance,
impacts, and scores for
Original set here.

2. Current: reflects most recent changes to probability and impact for each category. If you use
qualitative analysis, current chances and impacts are editable in Risk Register. You can also
edit them in the Risk Form or the Probabilities and Outcomes tab of the Risk Information
dialog box. For quantitative analysis (with project schedule) current set of probability,

impact, and scores is calculated based on risk assignment to task or resources. Current set of
probability, impact, and score is shown as a first line on Mitigation Tab on Risk Information
dialog box.
Mitigation Tab of Risk
Information dialog

Current any set of
probability, impact and
score is always shown on
first line.

Read only

3. Post-Mitigation: Post-mitigation probability, impact and score reflect changes to risks due to
mitigation plans There can be many mitigation plans assigned to one risk. They are editable
in the Assign Mitigation view and in Mitigation tab of the Risk Information dialog box. In
the Risk Register you can show the latest read-only probability, impact and score, which
corresponds to the last line in Mitigation tab. In the Assign Mitigation view, in addition to
editing the post-mitigation probabilities, impacts and scores for all categories, you can also
edit values for individual categories, such as cost, duration, quality, technology, etc.
Probabilities, impacts and scores for individual categories are not used to calculate combined
probabilities, impacts and scores, which should be entered independently. Post-mitigation
probabilities, impacts and scores are not affected by quantitative analysis. Also in the Assign
Mitigation you can enter both predicted and actual probabilities, impacts and scores.
Mitigation Tab of Risk
Information dialog

Insert new mitigation plan
and edit sets of
probabilities, impacts,
and scores here

Probability, impact and
score for the latest
mitigation plan will be
shown in Risk Register.

Risk Properties
Risk Properties are other risk attributes, which include:
•
•
•
•
•
•

Risk Name, ID, description, statement, objectives, assumption, cause and trigger
Open/close risk
Risk life cycle status: Risks, issues, lesson learned
Risk ownership
Risk mitigation strategy
Risk costs
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•

Risk start and end date
Other information about risk
Some risk properties are predefined as General Information about risk and Risk Costs. However,
you may define any other risk properties.
•

Risk Mitigation and Response Plans
You can model risk mitigation or response efforts in RiskyProject using the Mitigation or
Response View. Response plans are activities that are executed when a risk occurs and are used
for quantitative risk analysis. Mitigation plans are actions that are performed to minimize risk
probability and/or impact and can be visualized using the Risk Mitigation Waterfall diagram
A mitigation or/and response plan must be assigned to a particular risk. Please read “Assigning
Risk Response Plans” and “Assigning Mitigation Plans” for more information.

Creating a mitigation or risk response plan
1. Click the Risks tab. In the Risk Views group, click Mitigation/ Response Plans.
2. Enter the mitigation or response plan name. Summary entries will help you to organize
information, but they are not considered a mitigation plan.
3. Select either Mitigation or Response plan
4. For Response plans, enter an Outcome Type and Outcome of the response. The outcome
types are automatically populated based on the list of outcome types.
5. Enter the Cost of the mitigation or response plan
6. For Mitigation plans, enter the default reduction of probability and impact if the mitigation
plan is assigned to the risk.
For example, a mitigation plan reduces probability on 5% and impact on 10%. If a mitigation
plan is assigned to the risk that has 45% probability and 30% impact before mitigation, the
risk will have 40% probability and 20% impact after mitigation.
7. Enter the mitigation or response plan description. If you double-click on a
mitigation/response plan ID, the Mitigation or Response Plan Description dialog box will
open.
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Risk Attributes
About Risks
Each risk in RiskyProject can have a number of properties. Common properties are predefined
and are found in the Risk Form or Custom Properties tabs of the Risk Information dialog box.
The Risk Form is fully customizable: you can define a set of mandatory and optional attributes,
which need to be entered as part of your risk management process.
Risk properties include:
•
•

•

•
•
•

•
•

Risk Name: the risk name for each risk must be unique. Names are case-sensitive.
Open/closed risk: open risks are active risks that may occur. Closed risks are those risks
that are no longer active because of risk response or other factors or measures taken.
Closed risks may contain important information and should not be deleted from the risk
register.
Risks, issues, lessons learned: risks are events that may or may not occur and have a
probability between 0 – 100%. Issues are events that have already occurred and require a
response. Lessons learned are events that occurred in the past and have a history
associated with them. When you add a new record to the risk register, by default it is a
risk.
Risk statement, objectives, assumption, cause and trigger: contain textual information
about risks.
Risk ownership: includes risk manager and risk owner. You may define other custom
fields for risk reviewer, recorder, and other participants in the risk management process.
Risk mitigation strategy: you can enter mitigation strategies for threats and/or
opportunities. Status of threats and/or opportunities are automatically calculated when
you enter risk probabilities and impacts. If the risk is only a threat, you will only be able
to enter strategies for threats and vice versa. For more information about threats and
opportunities, read “Risk Probabilities and Impacts”.
Risk start and end date (risk sunrise and sunset): dates between which a particular
risk is active.
Risk ID: Risk ID can be automatically generated when you create a new risk. You may
sort the Risk Register based on Risk IDs. You can overwrite the automatically generated
risk ID. Rules for risk ID generation are defined in Risk Options. To view Risk Options,
click the Schedule tab. In the Settings group, click Options.

Risk Probabilities and Impacts
There are two ways probabilities and impacts can be defined in RiskyProject:
•
•

You can define chance and outcome for each risk in the Probabilities and Outcomes tab
of the Risk Information dialog box.
You can also define risk chance and outcome directly in the Risk Register grid. However,
in this case, risk cannot be assigned to any tasks or resources. If risk is already assigned
to at least one task or resource, you will not be able to modify chance and outcome using
the grid and the Risk Information dialog box will appear. This method is preferable for
qualitative risk analysis and risk management.

Defining risk chances and outcomes in the Risk Information dialog box
You must enter the risk chance, outcome type, and outcome for each risk. You may only define
one alternative. Please remember that risk chance and outcome may not be equal to calculated
risk probabilities and impacts in the following cases:
•
•
•

For risks with multiple mutually exclusive alternatives
If you define uncertainties in risk outcome
In case of quantitative risk analysis (with project schedule)

To define risk chances and outcomes in the Risk Information dialog:
1. Click the Risk tab. In the Risk Views group, click Risk Register.
2. Double- click on a risk ID to open the Risk information dialog box.
3. Click the Probabilities and Outcome tab.
4. Enter Chance that will be used to calculate probability.
5. Select Outcome Type from dropdown list.
6. Select Outcome label from dropdown list or enter percent.
7. Threat/Opportunity are calculated automatically if you enter a negative outcome.
8. If required, repeat steps 5 -7 for each mutually exclusive alternative.

Risk Form: Defining Information About Risks
The Risk Form is part of the Risk Information dialog and is used to define risk attributes. You
can customize the Risk Form to create any set to risk attributes which can be entered or edited.
Risk Form has two modes:
1. Editing Mode: you can drag and drop different controls to Risk Form and assign properties
to them. Controls such as edit boxes, drop down list, frames or static text can be selected
from the left side of the Risk Form dialog box and dropped on the form. After this you need
to select risk attributes associated with the control from the list of available attributes. For a
Static Text box you the enter text to be displayed, there are no risk attributes associated with
the frame.
2. Published Mode: when you complete design of Risk Form, click “Publish Risk Form
Layout” to switch to Published Mode. In Published Mode you can no longer edit Risk Form
layout, but you can enter risk attributes data. List of controls will be hidden.
To edit the Risk Form (Editing Mode):
1. Click the Risk tab. In the Risk Views group, click Risk Register
2. Double- click on risk ID to open the Risk information dialog box
3. Go to Risk Form tab; default Risk Form will be presented in Published Mode
4. Go to Editing mode by clicking on Edit Risk Form Layout
5. Clear controls if required by clicking on Clear All button
6. Select control using button on the right side.
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7. Click on Risk Form to select the position of the control
8. From the dropdown list above Risk Form select the property associated with selected control
9. Adjust size of the control but dragging its corners
10. Right click outside the control: shortcut menu will come up. You can Delete, Copy, or Paste
control, as well as make the property Mandatory. Once in Published Mode, all mandatory
fields must be filled to save data.
•
•
•

Click Save as Default to save newly designed Risk Form for all your new projects
Click Standard Form to restore standard if required
Click Publish Risk Form Layout to convert to Published Mode

To use Risk Form (Published Mode):
1. Click the Risk tab. In the Risk Views group, click Risk Register.
2. Double- click on risk ID to open the Risk information dialog box.
3. Enter risk attributes to the Risk Form
After you inserted the control,
select risk attribute from here.

Click here to toggle between Published
Mode and Editing Mode.

Click on button associated with control
from here and then click on Risk Form to
choose a location of this control.

Right-click outside the
control: a popup menu will
appear. You can Delete,
Copy, or Paste a field, or
make it mandatory.

Click outside the control to
select it and modify or
resize/move the field.

The Risk form has the following fields:
•
•
•

Number –real numbers, integer numbers, or cost properties
Edit Box –string (text) properties and organizational units
Dropdown List –picklist and Yes/No Properties

•
•
•
•
•
•
•

Dropdown Edit Box –risk, resources, and response plans
Date –date properties
Frame –frame or line separator; it is used to create visual separation between group of
control
Static Text –read only text used for prompts and annotations
Probability –risk probabilities belonging to different categories
Impact –risk impacts belonging to different categories
Threat/Opport. –selection of threats and opportunities

About Cost of Risk Calculations
The Cost Risk calculation calculates the total cost of a risk and takes into account the risk
mitigation plans linked to the risk. The Risk cost calculation is performed in the Risk Form tab
of the Risk Information dialog box. The Cost of Residual Risk and Potential Loss are the only
values that you can manually enter in the Risk Form. All other cost parameters are calculated.
You can modify Risk Form to show or hide different fields.

Risk cost calculation
Cost Before Mitigation

1. Potential Loss (property “Cost before mitigation”): the loss in monetary terms if the risk
occurs. This value can be entered manually if you select No for “Auto calculation of expected
loss (from Monte Carlo)” or if you don’t open a schedule.
For example, for the risk “low quality component”, the potential loss is $50,000. You
would incur this cost if a low quality component were supplied.
2. If you don’t open a schedule, the Probability Before Mitigation value is based on the risk
values entered in the Probabilities and Outcome tab of Risk Information dialog box. See
Risk Probabilities and Impacts for more information. If you have a schedule Probability
Before Mitigation comes from results of Monte Carlo simulations.
3. Expected Loss (property “Pre-Mitigation Expected Loss”) takes into account risk
probability. It is an indicator that helps you to compare the costs of different risks. Expected
loss can be calculated manually or automatically depending on selection “Auto calculation of
expected loss (from Monte Carlo)”.
a. Manual calculation of Expected Loss: You can manually calculate the expected loss
for individual risks by running two simulations: one with the risk open and the other
with the risk closed. The difference in the total project costs is the expected cost of
the risk.
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Expected loss = Potential Loss * Probability (pre-mitigation)
For example, probability of risk “low quality component” equals 50%. Potential loss
equals $50,000. Expected loss will be $25,000 = $50,000 * 50%.
b. Automatic calculation of Expected Loss is done based on results of Monte Carlo
simulations of project schedule:
Expected loss = (Project Cost with Risks – Project Cost Original) *
Correlation Coefficient
The correlation coefficient is calculated using project cost and cost increases due to a
specific risk occurring. For example, the project cost with risks and uncertainties is
$100,000. Project cost without risks and uncertainties is $90,000. In addition, the
correlation coefficient for the specific risk is 0.8. Expected loss will be ($100,000 $90,000)*0.8 = $8,000. The automatic calculation cannot be performed at the enterprise
level or on summary projects, as they do not include project activities. For automatic
calculation of Expected loss of the current project, RiskyProject will calculate Potential
Loss for current project = Expected loss / Probability (pre mitigation).

Cost After Mitigation
1. Cost of Response Plan. Even if a mitigation plan is executed as planned, there will still be a
cost associated with a risk, as it is possible to reduce risk, but not to eliminate it (an exception
is when you are able to avoid the risk). The response plan may be executed if the risk occurs
and will be calculated using the cost entered for the response plan associated with this risk.
This cost is entered Mitigation and Response view.
For example, if the risk “low quality component” occurs, this component needs to be
replaced with a new one, which would cost $20,000.
2. Residual risk may still exist after the risk response and is cost is calculated as the Cost of
Residual Risk.
For example, the new component installed as a risk response can still be defective. The
residual cost of the risk will be $10,000.
3. Probability After Mitigation comes from Mitigation tab of Risk Information dialog box.
See “Risk Mitigation and Response Plans” for more information.
For example: Risk Probability after mitigation equals 25% because of the execution of
the mitigation plan “additional QA procedure”, probability of risk “Low quality
component” is reduced two times.
4. Expected Loss After Mitigation (property “Post-mitigation Expected Loss”) takes in to
account the fact that risk may not occur.
Expected Loss After Mitigation = (Cost of Response Plan + Cost of Residual Risk) *
Probability After Mitigation
For example, probability of risk “low quality component” after mitigation equals 25%.
Expected loss after mitigation will be $7,500 = ($20,000 + $10,000) * 25%.

Other Cost Indicators (Properties)
1. Cost After Mitigation = Expected Loss After Mitigation + Cost of Mitigation

For example: Total cost after mitigation of risk “low quality component” will be $17,500
= $7,500 + $10,000
2. Saving from Mitigation/Enhancement is the difference between costs with and without
mitigation. If this number is negative mitigation efforts will not lead to cost saving.
Saving from Mitigation = Expected Loss – Total Risk Cost after Mitigation
For example, total cost after mitigation of risk “low quality component” will be $17,500.
Expected loss $25,000. Saving from Mitigation is $7.500. Because this number is
positive, it makes sense to perform mitigation efforts.

Assigning Risk Response Plans
Response plans defined in the Mitigation and Response view can be assigned to risks. Only one
response plan can be assigned to a particular risk.
Assigning Response Plan:
1. Click the Risks tab. In the Risks View group, click Risk Register.
2. Double- click on risk ID to open the Risk information dialog box.
3. Click the Risk Form tab
4. In the default Risk Form select a response plan from Response Plan dropdown list. These
response plans are defined in Mitigation/Response view.
5. If you are not using the default Risk Form, you can add the response plan dropdown list using
Dropdown Edit button in Editing Mode of Risk Form. See Risk Form for more information.
6. If you don’t see your response plan in the dropdown list, it means that the response plan is not
defined in the Mitigation/Response view. You still can enter Response plan name in
RiskyProject, but it will not be used for risk cost calculation.

Assign Mitigation Plans Using the Mitigation Tab
You can assign mitigation plans defined in the Mitigation and Response view to your risks. One
risk may have multiple sequential mitigation plans. They can be shown as a Waterfall diagram.
Waterfall diagrams can be used to visualize the timing of mitigation efforts over the course of the
project.
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Enter probability and impact
on each mitigation phase.
The score will be calculated
automatically.

Mitigation plan can be
assigned to a resource. It
is defined in the
Mitigation/Response view

Probability and
Impact of risk
before and after
mitigation are
shown here.

Enter the date,
when mitigation
efforts are expected
to start.

Enter the date,
when mitigation
efforts actually
started

Select a mitigation plan from the drop-down list.
You can also enter a mitigation plan here and it
will be automatically added to the Mitigation and
Response view.

Planned mitigation

Mitigation plans
can be linked
to a task.
Double click on
task ID to
define this task.

Mitigation cost. If
mitigation plan is linked
to a task, %
completed, cost and
actual will be taken
from task information.

Actual mitigation
based on Actual
Dates

Colors for the waterfall diagrams are defined
by the risk tolerance (see Format Risk
Matrix).

Viewing and editing waterfall diagrams:
1. Open the Risk Register view.
2. Double-click on Risk ID. The Risk Information dialog box opens.
3. Click the Mitigation (Waterfall diagram) tab.
4. Enable or disable Actual and Planned mitigation lines using check boxes on the left
bottom corner.
5. Double click on Mitigation Plan ID; the Mitigation Plan Properties dialog box opens.
6. Enter a mitigation description.
7. Select the task or summary task to assign it the mitigation plan. If mitigation plan is
linked to the task, cost, actual cost, and percent completed of the mitigation plan will
taken from task.
8. To delete the task assignment, click Clear task selection.

Risk Matrix and Risk Trend Chart
Risk Matrix and Risk Trend views allow you to determine the severity of a risk and analyze how
risks are changing over time:
•

•
•
•

The Risk Matrix is a tool that allows you to determine the severity of a risk. The Risk
Matrix view shows this using the risk probability (y-axis) vs. calculated risk impact (xaxis) of the project risks. The Risk Matrix view is divided into two sections: a table with
a list of risks with their actual calculated values for probability, impact, and score. When
you select these risks, they are shown visually on a matrix, which provides a visual
comparison of this data put as well as putting each risk into the context of your
organization’s risk tolerance. Changes in probability and impact due to mitigation plans
added to a risk’s mitigation waterfall chart will automatically be displayed in the Risk
Matrix.
The Risk History shows how the probability and impact of an individual risk has
changed over time.
The Risk Monitor shows the number of risks per cell in the risk matrix.
The Risk Trend shows how project risk change over time. The Risk Trend can be
presented as bar chart or in table format (Total Risks).

Viewing the Risk Matrix
1. Click the Risks tab. In the Risk Views group, click Risk Matrix.
2. Select type of chart you want to view at the bottom of risk matrix.
3. Select the Threats or Opportunities option at the top of the matrix. You cannot view Threats
and Opportunities at the same time
4. Risk scores can be shown on the Risk Matrix based on overall score (No Hierarchy) or a
selected risk category which are shown in the Hierarchy based on dropdown list. Lists of all
risks associated with the selection are shown in the table. Select No Hierarchy to view the
overall risk score (sum of all risk categories) for selected risks.
5. Select the check boxes beside the risk names to view the risks on the Risk Matrix. To hide a
risk, clear the check box. By default, risks with zero impact cannot be selected. Use the filter
at the bottom of the list (“Hide a risk if Score is < “ or “Show risks with severity level…”) to
show/hide risks below the entered threshold. Severity level is defined in Risk Trend Chart
Settings dialog. Essentially in the color of risk matrix.
To format the Risk Matrix, right-click on the matrix and choose Format Risk Matrix. For more
information about formatting the Risk Matrix, read, “Format the Risk Matrix and Risk Trend
Chart”.
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Select risk category to
view the risks

Threats and opportunities are
viewed separately

Arrows show changes in the
probability and impact of risks due to
mitigation plans

Select risk to display it
on the Risk Matrix

Number of risks
for each cell

How probabilities and impacts
of risks are changing over time

Filter: show risk based
on severity level

Viewing the Risk Trend Chart
Risk Trend shows how many risks belonging to different severity levels (colors) existed in a
certain time period. To view Risk Trend Chart:
1. Click the Risks tab. In the Risk Views group, click Risk Trend.
2. Select a chart type from the tabs at the bottom of the of chart..
3. Select the Threats or Opportunities option at the top of the chart. You cannot view Threats
and Opportunities at the same time
4. Select a No Hierarchy or a specfic risk category from the Hierarchy based on dropdown list.
Lists of all risks associated with the selection are shown in the table. No Hierarchy shows
the calculated overall risk score (sum of all risk categories) for selected risks.
To format the Risk Trend chart, right-click on the chart and choose Format Trend Chart. For
more information about formatting the Risk Trend Chart, read, “Format the Risk Matrix and Risk
Trend Chart”.

In this time interval it was:
•
8 very low impact risks
•
3 medium risks
•
1 critical risks

Copy the risk matrix and risk trend chart to the clipboard or save as a JPEG
file
1. Right-click on the Risk Matrix or Risk Trend
2. Choose Copy to Clipboard or Copy Chart to File (JPEG, PNG, GIF…).
3. If you chose to create a file, you will be prompted to select file format and save it to a
directory.
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Risk Dashboard
The fully customizable Risk Dashboard allows you to present hundreds of different KPIs and
charts related to your risks. You can create any number of dashboards with different information,
which are shown as different tabs within Risk Dashboard View. You can select from 7 types of
charts: line, area, pie, scatter, bar (including frequency histogram), different types of meters, and
risk matrixes. You can place them in different areas on the dashboard, adjust their size, colors,
and other properties. You can also annotate your dashboard with text, lines, and images.
When you modify your risk data, the charts and KPIs ARE automatically updated. This date
includes risk properties, mitigation and response plans, and project schedules. Annotation is not
updated when we update risk data.

KPI
Bar Chart
Line Chart
Area Chart
Meter
Risk Matrix
Pie Chart
Scatter Plot
Annotation: Line
Annotation: Image
You can create multiple
tabs (views) for Risk
Dashboard

Annotation:
Rectangle with text

To add a chart, KPI, or annotation to the Risk Dashboard:
1. Select the type of chart or KPI from the toolbar on the right side.
2. Click on the dashboard and drag the line or rectangle to select the position of the chart, KPI,
or Properties annotation.
3. Right click on chart, KPI, or annotation.
4. Select Properties from shortcut menu; Properties dialog opens.
5. Enter properties of the chart, KPI, or annotation; it includes type of chart or what type of data
this chart, KPI or annotation will represent as well as graphic properties.
6. Click Close to close the Properties dialog box.
To modify a chart, KPI, or annotation
1. Click on the chart, KPI, or annotation; chart, KPI, or annotation you want to modify.

2. Move or expand the area to adjust size or position of the chart, KPI, or annotation
3. Right click on chart, KPI, or annotation and click Properties from shortcut menu; Properties
dialog opens.
4. Modify properties of the chart, KPI, or annotation; it includes type of chart or what type of
data this chart, KPI or annotation will represent as well as graphic properties.
5. Click Close to close the Properties dialog box.
6. To enter text or update font and alignment, right click on KPI and Annotation rectangle and
select Edit or Format Text within a shortcut menu .
To export dashboard
1.

Right click in any place of dashboard, and from the shortcut menu click Copy Dashboard
to Clipboard or Copy Dashboard to File.

2. In you export dashboard to file, you can select file format: JPEG, PNG, GIF, BMP, or TIFF
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RiskyProject for Microsoft Project as a
Standalone Application
RiskyProject as a Standalone Application
You can launch RiskyProject directly from the Windows Program menu. When you open
RiskyProject, the main Project view appears in which you can enter schedule and risk, perform
the analysis, track project performance and report the results.

RiskyProject for Microsoft Project
RiskyProject seamlessly integrates with all versions of Microsoft Project from 2010 and later.
When you install RiskyProject, it checks if Microsoft Project is installed on the computer. If
Microsoft Project 2010 or later is, installed RiskyProject installs ribbon tab and Add-In to
Microsoft Project.
Here is how the integration works:
1. The first time you open Microsoft Project after installing RiskyProject for Project, check to
see that the RiskyProject ribbon tab is visible. You can enable/disable ribbon tab by clicking
on Options in the File menu. Project Options dialog will open where you can select
Customize Ribbon. You can also check the installed RiskyProject add-in by selecting AddIns.
2. Create a schedule in Microsoft Project.
3. Define uncertainties, perform calculation, and analyze results:
•

Define statistical distributions for cost and duration for selected tasks inside Microsoft
Project; all statistical distributions are saved in a RiskyProject file.
•
Add risk-related information in the RiskyProject views if necessary: risk events,
probabilistic and conditional branching, probabilistic calendars, etc.
•
Perform Monte Carlo simulations
•
View results of analysis and reports in Microsoft Project
4. At any moment, you can go back to Microsoft Project and make changes to your schedule.
All changes will be reflected in RiskyProject. However, if you make changes to the
deterministic project schedule in RiskyProject, these changes may be overwritten by the
Microsoft Project schedule.
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Click the Go Back to Microsoft Project button in
RiskyProject to view original schedule and resources

Use the RiskyProject toolbar or ribbon tab
in Microsoft Project:
1.

Define statistical distributions for
selected task or group of tasks

2.

Run Monte Carlo Simulations

3.

View results of selected task or group
of tasks

4.

Open the selected risk view or report
RiskyProject.

Microsoft Project

RiskyProject Add-In

Using Microsoft Project Add-In
Using the RiskyProject Add-In, you can quickly add Low and High estimates for Cost and
Schedule directly to your Microsoft Project file, run the simulation, and view the results of the
analysis.
Define
distributions

Run
Monte
Carlo

View results
for selected
tasks

View results
and
generate
reports

Diagnostics of
project schedule,
created in
Microsoft Project

Settings

Setting up the Add-In options
You can set up your Monte Carlo calculation, chart, and field mapping options using the Add-In.

•

•

Calculation options include the maximum number of iterations and convergence
monitoring and more. To read more about calculation options, read Error! Reference
source not found..
Field mappings allow you to modify the default fields where the distributions for duration
and cost are saved. To read more about the mapping, read Error! Reference source not
found.

Adding Low, Most Likely, and High Duration or Cost in Microsoft Project
1. Select one or more activities.
2. Click the RiskyProject 7 tab. On the Input Distributions group, click Duration or Cost.
The Statistical Distribution dialog box opens.
3. Enter in the Low and High estimates using coefficients or fixed values (single activity).
4. Select a distribution and modify any parameters required by the distribution. The “Most
likely” estimate is available for Triangular and BetaPert.
5. Click OK.
View results and
generate reports

Run Monte Carlo

Click to open dialog
box to add
distributions for
duration or cost
For multiple tasks
enter coefficients for
Low and High
estimates and select
a distribution

To clean edits made to distributions:

1. Select the task or tasks in which you want to remove the distributions.
2. Click the RiskyProject 7 tab.
3. On the Input Distributions group, click Clean.
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Run a Monte Carlo simulation using the Microsoft Project Add-In
Once you have defined the low, most likely, and high estimates and distributions to your
activities, you can run a simulation.
To run a Monte Carlo simulation:
1. Click the RiskyProject 7 tab.
2. On the Input Distributions group, click Calculate. A progress bar will open and indicating
the number of iterations that have been completed.
3. When the simulations are completed the Project Information report opens, which contains a
project summary of the results of the simulation.

View the results of the simulation for a task
You can quickly view either histograms or tornado charts for a task. Only one task can be
selected.
To view a histogram or tornado chart for a single task:
1. Click the RiskyProject 7 tab. On the Task Results group, click Histograms or Tornado.
The Task Simulation Results report opens. To read more about these reports, see
2. Viewing Task Simulation Results.
3. Double- click on any of the reports to open a detailed view of the results.

Create a statistics report
You can automatically generate a report that includes a histogram, cumulative probability, and
sensitivity analysis for one or multiple activities using the Statistics Report. To read more about
the Statistics Report, see Error! Reference source not found..
To create report:
1. Run a simulation.
2. On the Task Results group, click Statistics Reports. The Statistics Report view opens.
3. Select the activities that you want to include in the report.
4. From the File menu, click Print to open the Print Options dialog box.
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Creating Projects
Creating a new project
The original view for a new document is defined in the Options, View tab. The default view can
be the last view in the previous RiskyProject session.
1. Click File

and then New. The new project file opens.

2. To save the project click the Save button and type in a project name.
In addition to project files created in RiskyProject, you can also open files that have been saved
as a Microsoft Project XML and Oracle Primavera XER format. Microsoft Project XML is the
industry standard for project management software and is supported by Microsoft Project,
Oracle Primavera, and many other project management software applications.

Importing existing project schedules
You can import existing project schedules from Microsoft Project, Primavera and other project
management tools using a variety of file formats.

Importing Microsoft Project files
You can import MS Project files using XML formats.
1. Click File

and then Open. The Open File dialog box opens.

2. Select the format that the project file is in from the Files of type drop-down list.
3. Select the MS Project file format that you just saved.
4. Click OK.

Project Tasks
When you first start RiskyProject, the Project view opens. Start the scheduling process by adding
tasks. Each task should have a name and a base duration. You can enter this information directly
onto the datasheet or using the Task Information dialog box.

Opening the Task Information dialog box
The Task information dialog box can be used to enter task parameters (duration, start, finish
times, assign resources to tasks, assign risks, etc.). You can open the task information dialog
using one of the following ways:
•
•
•

Double-click on Task ID
Right-click on task ID and Select Task Information
Select Task and Click on Project > Task Information

Entering task name and duration
When you create a task, the first step is to enter a name and a base duration.
1. Click on the Task Name field in the Project view.
2. Provide a name for the task.
3. Enter a base duration in the Base Duration field. You can enter elapsed duration. Elapsed
task duration is calculated using a 24-month calendar. To define elapsed duration, enter ‘e’
before units, for example, “10 edays”.

Defining summary tasks and subtasks
Summary tasks represent groups of tasks (subtasks) that can be logically grouped together under a
larger task. In large projects with many tasks, this is a useful method of organizing your tasks.
1. Create a task directly above the tasks that you want to group under it. This will become the
Summary Task.
2. Select the tasks that you want to be the subtasks of the summary task you created in step 1.
3. Click the Indent button located on the Format toolbar to indent the tasks. The indented tasks
are automatically recognized as subtasks of the summary task. If you want to move at task out
from under the summary task, select the task and click the Outdent buttons. After you click
on an Indent or Outdent button, RiskyProject automatically recalculates the project.

Use this buttons to
change the level of
the tasks
Expand or collapse
summary tasks

Select tasks that you
want to be subtasks
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Outline Selected Level
You may view summary tasks associated with a particular level of the hierarchy using the Outline
button (Schedule tab).

Task Links
All projects require that the WBS tasks be performed in a certain order. These relationships are
defined in RiskyProject using the four linking buttons located on the standard toolbar.

The four types of task dependencies are show in the following figure:

If you want a next task to be a predecessor of a previous task, for example task 5 to be a
predecessor of task 3, you will have to use Predecessors tab in Task Information dialog box. You can
also use the Predecessors tab if you want to define lags time greater than zero.

Remember the following rules:
1. You cannot link summary
task to one of its subtasks

2. The predecessors of a
summary task must have a
finish-start or start-start
dependency.

3. You cannot create circular
relationships.

The connecting line between successors and predecessors will be red if there is a scheduling
conflict:

Predecessors and Lags
You define information about predecessors and lags in the Predecessor tab of Task Information
dialog box.
You can use the Standard toolbar button to link tasks; however, this method of creating task
dependencies has limitations:
•
•

You cannot link a task (from example Task #5) to a previous task (for example Task #3).
You cannot input lag, which is time delay between predecessor and successor.
RiskyProject allows you to setup probabilistic lag with statistical distribution defined by
low, base, high number.

Sometimes it is convenient to use predecessor tab instead of link toolbar buttons when task has
multiple predecessor or if there is a big difference in task Ids between current task and predecessor.
For example, it is not convenient to link task number 5 to task number 74 using toolbar buttons.
You can use Predecessor column within Project view to define or modify predecessors. Text: “1, 2+2
days” would mean than current task has two predecessors (Task 1 and Task 2 with lag 2 days).

Adding a predecessor to a task
1. Select the task to which you want to add a predecessor.
2. Open the Task Information dialog box.
3. Click the Predecessor tab.
4. On the first row of the grid, click in the Task Name cell. A drop-down list appears containing
a list of all available tasks or type
5. Select the predecessor from the drop-down list. By default, the predecessor type is FinishStart (FS).
6. If required, enter a lag time. Use the Lag low and Lag high cells to enter a range of time. Lag
can be positive or negative
7. If you are entering a base, high and low lag, you can change the default distribution using the
drop-down list in the distribution cell.
•

If the low and high lags are different, the default distribution is triangular.
If low, base, and high lag are the same the distribution is undefined.
8. If required, edit the Seed number. Seed is the starting parameter used for the random number
generation that is used to calculate lag. If you have two predecessors, and they have strong
positive correlations between their lags, you can make their seeds the same. For example, a
low lag for one predecessor will coincide with a low lag for another predecessor.
•

9. Click OK.

RiskyProject Professional Getting Started Guide

Constraints
Constraints are limitations that you set on tasks. For example, you can specify that a task must
start on a particular date or finish no later than a particular date. In RiskyProject, you can assign
one of seven constraints to a task:
•

As soon as possible (default)
Start no earlier than
•
Must start on
•
Must finish on
•
Start no later than
•
Finish no earlier than
•
Finish no later than
Summary tasks have only “As soon as possible” and “Start no earlier than”.
Use the General tab of Task Information dialog box to add or modify constraints. If you set a
constraint to Start no Earlier Then, an additional edit box opens in which you set the date for this
constraint.
•

If you assign a constraint other than As Soon As Possible, the background color for low, base,
and high Start Times or low, base and high Finish Times changes to orange to indicate that the
constraint is other than As Soon As Possible.
A red dot indicates that the constraint is
not set to As Soon As Possible, Must
start on and Must finish on

Shading constrained time (rather than
As Soon As Possible)

Use constraints to ensure that the task starts or finishes on the specific dates. Use caution when
you link tasks with a constrained start or finish time with predecessors because of the potential for
scheduling conflicts. In this situation, to avoid scheduling conflicts, set the constraint to As Soon
As Possible.
Constraints affect both probabilistic and deterministic calculations. If you change the Low or
High Start times, the constraint is set to Must Start On, similar to when you change the Base Start
time.

Adding constraints
Before you add a constraint, you should define the task name and duration.
1. Double- click the task to which you want to add a constraint.
2. Click the General tab.
3. From the Constraints drop-down list, select a constraint that you want to add to the task.

Milestones
You can flag a task as a milestone. If you turn on a milestone, the task bar within a Gantt chart is
displayed as:

Any task with zero duration is automatically displayed as a milestone in the Gantt chart; however,
any task can be marked as a milestone. The milestone flag is for display only and does not affect
the project calculations.
If a task has no duration entered, it is automatically displayed as a milestone, and you do not have
to complete the following steps. If you want to flag a task that has duration, complete the
following steps.

Creating a milestone
1. Select the task that you want to flag as a milestone.
2. Open the Task Information dialog box.
3. Click the Advanced tab.
4. Select the This task is a milestone check box.
5. Click OK.

RiskyProject Professional Getting Started Guide

Managing Resources and Work
Resources are the people and equipment that are assigned or the material that is used to complete
a task.

Adding resources
1. Click the Schedule tab. In the Schedule Views group, click Resources.
2. Click on a row.
3. Provide a Name (mandatory), Initials (optional), and Rate (mandatory).
•

You can group resources to define reams using the indent and outdent buttons.
Initials and notes are for information only and do not affect the calculations.
•
Rates affect the cost the task to which the resource is assigned. Rates for work resources
can be per year, month, week, day, hour and minute. Rates for material resources are per
unit (e.g., 10 tons).
4. Select the resource type: Material, Cost or Work.
•

•
Material label indicates type of material resources (e.g., tons)
5. Maximum units are used to calculate Overallocation of work resources. It is not used for the
material or cost resources.

Assigning resources to tasks
1. On the Schedule tab, in the Schedule Views group, click Project View.
2. Select the task to which you want to assign the resource.
3. Click in the Resource field associated with the task.
4. Select a resource from the drop-down list. If you type in a new resource name, it will be
added to the list of resources in the resource view. When you add a new resource in this
manner, it will be assigned at 100% effort for work resource.
5. Enter Cost for cost resources

Assigning a calendar to a resource
1. By default, RiskyProject assigns the Standard calendar to resources.
2. On the Resource view, double-click on a resource ID.
3. Select a resource calendar from the Base Calendar drop-down list.
4. Click the Working Time button (Schedule tab) to modify the resource calendar.

Defining work
You can enter tasks as work rather than duration. The Work view shows the total work of all
resources assigned to a task.
1. On the Schedule tab, in the Schedule Views group, click Work.
2. Select the Task type: fixed units, fixed duration, or fixed work. The same information can
be defined using Advanced tab of Task Information dialog box

3. Check the Effort driven flag if the task is effort driven (default value). Effort driven task can
be defined in the Advanced tab of Task Information dialog box.
4. Enter low, base, and high work for the selected task. Units for work are defined in the Tools
> Options > Duration tab. Duration and units for the task will be calculated based on task
type.
•

For probabilistic calculations, work is always correlated with duration. Seed and distribution
of the duration are used for work as well. Therefore, seed and distribution for work are not
entered.

•

You may view work assigned to the particular resource in the Resources tab of Task
Information dialog box.
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Managing Costs
Cost, Income, and Profit Calculations in RiskyProject
You can define cost and income associated for tasks with risks and uncertainties. You can use
income to perform an analysis of the full life cycle of a project. Profit is calculated as the
difference between income and cost. This will affect the way that RiskyProject presents data in
the Cost and Cash Flow views. If the project has income, all cost and cash flow, data is now
shown as Profit where costs are a negative value. In these cases, it is possible that a project will
have negative profit.
The example below illustrates how fixed, and variable (resource) costs are calculated with respect
to tasks and subtasks:

The project schedule includes the summary task “Web Site Design”, the summary task “Art
Works”, and subtasks “Selection of artwork” (2 days duration) and “Purchase of art work” (0.2
days duration). “Selection of artwork…” has base fixed cost $200 and is assigned to the Graphic
Artist with rate $50.00/hour. “Purchase of artwork” has a base fixed cost of $400 and is
performed by Purchaser with a rate of $40.00/hour. The work is supervised by project manager
with rate $80.00/hour, but only 10% his time is assigned to this project. It is assumed that a day
has eight (8) working hours.

The Fixed cost for the summary task is calculated as the sum cost of all subtasks, which do not
have subtasks under them. Resource costs for summary tasks are calculated as cost of all
resources assigned to summary task plus resource cost of all subtasks.
A. Calculation of base fixed cost for summary task “Web Site Design”:
Base fixed cost for “Selection of artwork…” (Task 3)

= $200.00

Base fixed cost for “Purchase of artwork” (Task 4)

= $400.00

Total = $600.00
B. Calculation of variable (resource) cost for summary task “Web Site Design”:
Resource cost for project manager = 17.6 hours * $80/hr / 10

= $140.80

Resource cost for Selection of artwork (Task 3) 16 hours * $50/hr = $800.00
Resource cost for Purchase of artwork (Task 4) = 1.6 hours * 40/hr = $64.00
Total = $1004.80
Income is calculated similarly to cost calculation. Income cannot be assigned to the resources.

Variable and Fixed Costs and Income
There are two types of costs in RiskyProject:
•

Fixed costs, which are associated with tasks; and,
•
Variable costs, which are associated with resources.
Costs associated with resources are calculated based on rate, units assigned, and work of the
particular resource.
Income is always fixed. You define it in the same manner as fixed costs. Both fixed cost and
income can be accrued at the beginning of the task, at end of the task or be prorated.
You define and verify costs and income in the Cost and Income tab (Schedule tab if the
workflow bar) and report results within Profit Report view (Report tab).

Adding fixed costs and income to tasks
The Cost and Income view also shows the calculated results for fixed costs and resource costs.
1. On the Schedule tab, click the Cost and Income view.
1. Select the task in which you want to include fixed cost or income.
2. Enter base fixed cost in the Cost field. You can enter in Low and High estimated costs.
3. Select an accrual method in the Accrual column. Accrual methods indicate how cost or
income is accrued in the task. Default accrual method if defaulted in Tools > Options, cost
tab separately for cost and income. Accrual methods available are:
•

Start
Finish
•
Prorated
4. Enter Income in the same manner as above.
•
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Assigning Risks to Tasks and Resources
Risk Assignments
Risks must be assigned to calculate their impact. If a risk is not assigned to any tasks or resources
it will remain in the risk register, but probability, impact, and score will not be shown.
RiskyProject has two types of risks assignments:
•

•

Global Risk Assignments – Global risk assignments are those risk assignments that have
a chance of affecting the project as a whole and are not limited to specific tasks or
resources. For example, political or weather risks would be assigned as global.
Local Assignments – Local risk assignments are those risks that have a chance of
affecting only specific tasks or resources. A local risk assignment can affect more than
one task or resource. For example, risks affecting the delivery of specific equipment for a
certain phase of a project would be assigned local.

You can edit or view risk assignments in the following dialog boxes and views:
View

dialog box/Tab

Local or Global

Assigned to
tasks or
resources

Drag’N’Drop Risk View

Local risks

Both task and
resources

Risk Assignment View

Risks can be re-assigned
to different tasks or
resources or become
global

Both task and
resources

Risk Register

Risk information
dialog (double-click
on Risk ID),
Assignment tab

Both local and global risk

Both task and
resources

Any view with task
information (Project
View, Result Gantt, etc.)

Task information
dialog (double-click
on Task ID), Risk tab

Local risks

Task

Resource View

Resource
information dialog
(double-click on
Resource ID), Risk
tab

Local risks

Resources
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Converting your project from Qualitative to Quantitative Risk Analysis
If you have risks in the Risk Register, but no schedule, you can perform a qualitative risk analysis
of your project. If you add even one task to the project, all your risks will convert to global risks,
and will therefore be assigned to all tasks.
In quantitative risk analysis risk categories are separated into two groups:
•

•

Schedule related risk categories: “Schedule and Scope” which is related to category
“Duration” in qualitative analysis and “Cost and Income” which is related to category
“Cost” in qualitative analysis.
Non-schedule categories (Safety, Quality, Technology, etc.)

In qualitative risk analysis the “Duration” category has only one outcome type “Relative delay”;
however, in quantitative analysis, the corresponding category “Schedule and Scope” has many
outcome types (fixed delay, relative delay, etc.). Similarly, in qualitative analysis the“Cost”
category has only one outcome type, “Relative cost increase”; whereas the “Cost and Income”
category in quantitative analysis has many outcome types (fixed cost increase, relative cost
increase, etc.).
If you add a schedule (i.e. activites or tasks) to your project, the following occurs:
•
•

Risks with the outcome type “Relative Delay” will convert to a global risk with the same
outcome type.
Risks with the outcome type “Relative Cost Increase” will convert to a global risk with
the same outcome type”.

At this point, you may need to reassign these risks to particular tasks or resources and modify the
outcome types. For example, a risk which had a Relative Cost Increase may need to be modeled
as a Fixed Cost Increase.
•

The Probabilities and impacts of schedule related risks in quantitative analysis are
calculated differently than in qualitative analysis.
•
Schedule related risk impacts are calculated as a correlation between the duration or cost
impact for each risk and project duration or cost.
•
As a result, probabilities and impacts of schedule risk for quantitative and qualitative
analysis will be different.
For more information about calculation of probabilities and impacts of risks for quantitative
analysis read, “How are risk probabilities, impacts, and scores calculated?” in the Frequently
Asked Questions.
•

The risk register has an additional column for quantitative risk analysis: risk assignment.
To view pre- and post-mitigation probabilities and impacts for quantitative risk analysis,
you must calculate your project.

•

When you have a project with a schedule, the Risk Assignment view is enabled. The Risk
Assignment icon will be disabled in the workflow bar for qualitative analysis (no
schedule).

•

When you remove a schedule but do not remove risks, you will be performing qualitative
risk analysis.

Risk Attributes for Quantitative Risk Analysis
Each risk has the following information related to quantitative analysis.
•
•

•

Risks can be assigned to Tasks or Resources
Risks are defined by the chance of occurrence (from 0% to 100%). The chance can be
defined per task (by default) or per duration unit. For example, if there is a 30% chance
that task can be restarted per day. If task duration is 2 days, the chance of the risk
occurring per task is 60%. This chance calculation option is defined for all tasks and
resources for the project in the Risk tab of the Options dialog box:

Each risk has a different outcome type. Outcome types can be schedule and cost related
and non-schedule related, which you can customize using the Risk Outcome dialog box.
Standard schedule-related risk outcomes are shown in the table.

Outcome Type

Description

No Impact

This is for information only and has no impact
on project schedule

Relative Delay

Durations will be expanded in the period,
defined in the Result field regardless of,
when the risk occurs. If the Result is
negative, the task duration will be reduced. If
task duration is elapsed, the delay will also be
represented in elapsed units (edays, ehour,
etc.)

Fixed Delay

Relative Cost
Increase
Fixed Cost Increase

Relative Income
Increase
Fixed Income
Increase

Task related fixed costs are increased by the
amount, defined in the field Result regardless
of when the risk occurs. If the Result is
negative, costs are reduced. These risks do
not affect cost per use.
Works in a similar manner to fixed cost
increase and relative cost increase but
applied to the income.

Restart Task

Tasks are restarted from the moment the risk
occurs. As a result, the task duration is
increased.

End Task

Tasks are successfully completed when the
risk occurs. As a result, the task duration is
reduced.

Cancel Task

Tasks are canceled when the risk occurs. As
a result, the task duration is reduced, and the
task is marked as canceled.
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Cancel Task + all
successors

Tasks and all its successors are canceled
when the risk occurs. As a result, the task
duration is reduced, and the task and all its
successors are marked as canceled.

Rate Increase

This risk can only be used on resources. If
this risk occurs, the rate will be increase or
reduce. For example, if the rate is $20/hour
and risk outcome is 50%, the rate will be
$30/hour if the risk occurs. This outcome
affects project cost.

Execute Response
Plan

Result field for this risk contains a dropdown
list with mitigation plans. They come from
Risk Mitigation or Response view. If task has
multiple local and global risks, which require
execution of the particular mitigation or
response plan, this plan will be executed only
once.

The Outcome is related to the outcomes “Fixed cost increase”, “Relative cost
increase”, “Fixed delay”, “Relative delay”, and “Rate Increase”. It defines how much
the duration or cost will be increased or reduced.
•
RiskyProject calculates the Risk Impact for duration and cost using sensitivity analysis
and displays this in the Risk Register, Risk Assignment views and Risk Tabs for Tasks
and Resources. Colors are used to indicate the level of correlation between the risk and
project duration and cost.
•
Red indicates a strong correlation
•
Yellow a medium correlation
•
Green a weak or no correlation
Colors for threats are the opposite. Particular colors for the risk impact value depend on the
risk tolerance defined in Format Risk Matrix dialog box.
•

Assigning local and global risks
Once you have added your risks you can start assigning your local risks to tasks and resources.
You cannot assign the same local risk to both a task and a resource. RiskyProject offers a number
of ways to assign risks to task and resources.

Method 1: Assigning risks using the Drag’N’Drop Risk view
This is the preferred method for assigning risks to complex projects as it allows you to quickly
assign risks to multiple tasks or resources.

3. Select tasks or resources your
risk will be assigned to

4. Select one risk

1. Click
Drag’N’Drop Risk

5. Drag the risk on
the tasks or
resources

2. Select do you want to assign your
risks to task or resources

1. On the Risks tab, click the Drag’N’Drop Risk view.
2. You must indicate whether you are assigning the risk to Tasks or Resources using the options
below the list of tasks or resources. Select Task or Resources and the right pane will list
change based on your selection. By default, the view is set to Tasks.
3. Select tasks or resources your risk will be assigned to.
4. Select one risk.
5. Drag risk onto the tasks or resources.
6. The Assign risk to task or resource dialog box opens. It shows a list of the task or resources
that the risk will be assigned to and allows you to define risk chance, outcome type, outcome,
and moment of risk
7. Select whether you want to add or update a risk for the specific task or resource or if you do
not want to make any changes to risk assigned to the specific task
8. Enter the risk chance, outcome type, outcome and moment of risk. These parameters will be
the same for all selected tasks.
9. Click OK. The risk assignment to the selected tasks or resources is updated.
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Managing Uncertainties
If you have accurate historical statistical data that is analogous to a particular element in your
project, we recommend that you use this data to model uncertainty in your project as opposed to
risk events. Be aware of double-counting risk and uncertainty as most of the uncertainty in a
project is due to the probability of risk events occurring.
To define uncertainties:
1.

Define a 3-point estimate for any of task parameters: fixed cost, income, duration, and start
time. 3-point estimates for work will be calculated automatically based on uncertainty in
duration. You may also define 3-point estimates for the lag.

2.

You can define a Most Likely duration or fixed cost. By default, Most Likely duration or
fixed cost equals Base duration and Fixed Cost. However, you can define separate Most
Likely values. This can be used if you believe that the Base values from original project
schedule is not realistic, but you want to maintain the original Base values. Most Likely
values are used only with Triangular and BetaPert distributions.

3.

After you define 3-point estimates, a statistical distribution will be assigned. You may change
the default statistical distribution for the duration, cost, income, and start time parameters in
the gf Distributions tab of Task Information dialog box.

Adding 3-point estimates for task duration and start times using Task
Information Dialog
1. On the Project view, double-click on the task ID.
2. Click the General tab.
3. Define a Base, Low, and High dates for Duration and/or Start Time.
4. Define a Base, Low, and High values for Duration. By default, when you enter a value for
duration, the default values for Low and High are calculated based on the defaults set in the
Duration Options.
5. Click OK to save the estimates.

Adding 3-point estimates for task duration using the Project View
1. On the Project view, select the task to which you want to add cost and income estimates
2. Enter cost data for Duration Low, Duration Base, and Duration High. By default, when
you enter a value for Duration Base, the default values for Low and High are calculated based
on the Duration defaults set in the Duration Tab of Project Options dialog.
3. You may define a Most Likely Duration. The Duration Most Likely column is hidden by
default, so you will need to insert the to your datasheet. To insert column right click on
column header, choose “Insert Column Before…” or “Insert Column After…”, and select
Duration Most likely.

Adding 3-point estimates for task cost and income
1. On the Cost and Income view, select the task to which you want to add cost and income
estimates

2. Enter cost data for Cost Low, Cost, and Cost High. By default, when you enter a value for
Cost, the default values for Low and High are calculated based on the Cost defaults set in the
Cost Tab of Project Options dialog.
3. You may define a Most Likely Duration. The Duration Most Likely column is hidden by
default, so you will need to insert the to your datasheet. To insert column right click on
column header, choose “Insert Column Before…” or “Insert Column After…”, and select
Duration Most likely.
4. Enter income data for Inc. Low, Income, and Inc. High.

Adding 3-point estimates for lags
1. On the Project view, double-click on the task ID.
2. Click the Predecessor tab.
3. Enter Low, Base, and High Lag. Default statistical distribution will be generated
automatically. There are only two distributions for lag: Uniform Triangular.
4. Click OK to save the estimates.

Distributions for 3-point estimates for duration, cost, income, and
start time
You define distributions for 3-point estimates in duration, start time, income and cost in the
Distributions tab of Task Information dialog box. Distribution for work is the same as
distribution for duration. Distributions do not affect the deterministic calculation of current
schedule. You cannot define distributions for summary tasks.
The Distributions tab allows you to assign distributions and define the meaning of low and high
values for normal and lognormal distributions. The actual values for low, base (most likely), and
high duration, cost, and start time are defined when you enter task parameters in data sheets. Low
and high duration and start time can be entered in General tab of Task Information dialog box
of in data sheets. Seeds, which are associated with the distributions, are defined in data sheets.

Defining task distributions
1. Select the task in which you want to define distributions.
2. Open the Task Information dialog box.
3. Click the Distributions tab.
4. Select the Cost, Duration or Start Time tab.
5. Select the distribution from the Distribution list. If you select Undefined, the base value will
be used for all iterations.
6. Define the distribution parameters. The Probability Density chart is automatically updated.
You can adjust distribution parameters using the sliders.
7. If you use a custom or discrete distribution, a grid opens. The grid will allow you to define
points (or intervals for discrete distributions) and associated with each point (interval)
8. If you select Normal or Lognormal, you must select the Low and High probability range
(P1 and P99, P5 and P95 or P10 and P90). These are “cut-off” parameters; meaning that
duration, cost, or start time cannot go beyond these values.

Calculations
RiskyProject has two types of calculations:
•

•
•

Deterministic calculation of current schedule - The default calculation is automatically
performed when you modify a project schedule. As this calculation occurs automatically,
you do not need to press the Calculation button. This calculation uses the Base input
parameters (duration, start time, lag) without calculating the effect of risk or uncertainty.
Probabilistic (Monte Carlo simulations) - Use this to calculate the project schedule and
costs with uncertainties and risks.
Automatic Monte Carlo simulations for small tasks are enabled by default.

Enabling or disabling automatic Monte Carlo simulations for small projects
1. Click the Schedule tab. In the Settings and Options, click Options. The Options dialog box
opens.
2. Click the Calculations tab.
3. From the Default Calculation for Small Projects option box, select one of the two options:
•

Current Schedule Calculation only
Probabilistic Calculation (Monte Carlo simulation)
4. Click OK. RiskyProject automatically determines which project is small based on your
computer’s performance and the size of the project.
•

Running probabilistic calculations
Click the Calculate button. You may cancel the probabilistic calculation at any time; however, if
the number of simulations performed is less than 20, no probabilistic results will be calculated.

Defining the number of simulations
You can define the total number of simulations run during each probabilistic calculation.
1. Click the Schedule tab. In the Settings and Options group, click Options.
2. Click the Calculations tab.
3. Type in the number of simulations in the Maximum number of simulations box. The
number of simulations that have actually been run could be less if the simulations converge.
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Analyzing Results
Project Summary
The Project Summary view shows the main information about your project: total cost or income
(if income is defined), finish time, duration, and success rate for both deterministic and
probabilistic calculations.

Main Project
information. You
can also enter or
modify this
information in the
Project Settings
dialog box

This table shows the project parameters for:
A.

Current schedule (no risks) and

B.

Probabilistic calculations (with risks).

Use meter to see risk
score for project cost and
duration

The cells related to probabilistic results will be blank if
probabilistic calculations have not been run.

Right-click on a chart to
view menu items that
provide analysis and
output options.
Move the slider to view
the chance that cost,
duration or finish time
will be less than a
certain value.

If your project has any
income, this will be the
project profit.

Interactive frequency charts represent the
risk profile of the project. Double-click on a
chart to open the Detail view of the chart.

The Project Summary is divided into four sections:
•
•

•

Main project information – the main project information includes the project name,
manager, etc.
Main project parameters with and without risks – this table is located in the center of the
project summary and shows the project start time, duration, finish time, cost, income, and
profit for the current schedule (no risks) and the low, base, and high calculated results.
Main project parameter frequency/cumulative probability charts – interactive charts that
show the distribution of the results.
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•

Meters: provide project risk scores for cost and duration. You can adjust the scale and
calculation formula for project meters by clicking on the question mark (?) on the left
bottom corner of the duration meter. You can also define a formula for project risk score.

Results Gantt Chart
RiskyProject displays the start and finish ranges of each task in the Result Gantt view. The
calculated project and baseline schedules are shown in the same Gantt chart. You can use the task
bar for current schedule to compare deterministic and probabilistic schedules.
Task bar for deterministic schedule

Low Start Time

Mean Start Time

Low Finish Time

Mean Finish Time

High Finish Time

High Start Time

You can display Result Gantt associated only with low (optimistic) and high (pessimistic) results.

Showing or Hiding Low/High Results
1. Right-click on the chart and a shortcut menu opens.
2. From the shortcut menu, choose one of the following viewing options:
•
•
•
•

Show Low/High Results
Show Low Results
Show High Results
Show Current Schedule.

Task Simulation Results
RiskyProject allows you to quickly view the cost (profit, if income in any task is defined),
duration, start time and finish times uncertainties associated with each task.

Double-click on a chart
to see larger chart with
more information
including statistics and
raw data.
Right-click on a chart to
copy the chart, statistics
or data to the clipboard
or view cumulative
probability, frequency
charts, or their
combination.

After you have completed a probabilistic calculation, you can see the probability that the
particular task will start and finish on particular dates and will have a duration and a cost less than
a certain value. The six charts available are for:
•
•
•
•
•
•

Cost (Profit
Duration
Start Time
Finish Time
Variable cost
Work

Viewing Task Simulation Results
1. Right-click on a task ID in any view. A shortcut menu opens.
2. Choose Task Simulation Results from the shortcut menu. The Monte Carlo Simulation
Results dialog box opens.
3. Drag the slider across the charts to view the chance of a certain result.
4. Double-click on a chart to open up a detailed view of the chart.
•
•

Click the tabs on the top of the charts to toggle between Frequency, Cumulative
Probability views, and their combination.
Click the Statistics, Data, or Percentiles to view more detailed views of the result data.
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•

If you created at least one baseline with results of analysis, you will see a detailed chart
with multiple cumulative probability plots. A list of baselines is shown in the left bottom
corner of the dialog box. You can enable and disable plots, as well as change colors for
the plots. By using multiple cumulative probability plots, you can compare uncertainties
in different project scenarios for particular task or for whole project.

Curves are associated
with results of analysis
for different baselines
Enabled
cumulative
probability curve
for this baseline

Double click
to modify
plot color

This table will be shown only when you have at least
one baselines with results of analysis.
Baselines can be set using Schedules -> Baseline ->
Set

Resource Allocation
The Resource chart shows the time allocation for a selected resource.

Frequency chart shows
the current schedule

Select a checkbox to
indicate the data that
you want to view in the
chart. You can view
baseline or probabilistic
results

Overallocation
Select a checkbox to
indicate which resource
time allocation will be
shown on the chart.
Only one resource can
be selected at a time.
Right-click on the chart
to open a shortcut
menu. You can select
Zoom In, Zoom Out,
and Zoom All

For the resource chart to open, two conditions must be met:
•
•

You must select the Chart check box for a resource in the resource sheet.
The selected resource must be assigned to a task.

You can select four different types of resource charts:
•
•
•

•

Peak units: The highest level at which a resource is scheduled for all assigned tasks
during a given period.
Work: The total number of hours a resource is scheduled for all assigned tasks during a
given period.
Overallocation: A resource is over allocated when it has more work assigned than can be
done in the resource’s available time. Overallocation is number of hours a resource is
scheduled for all assigned tasks over resource’s available time. Overallocation can be
shown only for work (not material and cost) resources.
Percent allocation: The percentage of a resource’s capacity taken up by all of its
assigned tasks during a given period. Percent allocation is only available for work (not
material and cost) resources.
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Analyzing Cost and Profit
Use the Cost Analysis view to analyze cost and profit on each stage of the project. The Cost
Analysis view has up to five cost diagrams:
Cost diagram

Description

Color

When it is shown

Current schedule
(budgeted) cost or profit

Cost diagram with current
project schedule (no risks)

Red

Always when cost or profit for any task is defined

Result cost (Low)

Cost diagram with risk and
uncertainties (calculation
results, low estimate)

Blue –
dashed
line

Shown after calculation if uncertainties are defined
and Low Result Cost Chart is selected from
shortcut menu (right click on the chart)

Result cost (Base)

Cost diagram with risk and
uncertainties (calculation
results, base estimate)

Blue

Shown after calculation if uncertainties are defined
and Base Result Cost Chart is selected from
shortcut menu (right click on the chart)

Result cost (High)

Cost diagram with risk and
uncertainties (calculation
results, high estimate)

Blue
dashed
line

Shown after calculation if uncertainties are defined
and High Result Cost Chart is selected from
shortcut menu (right click on the chart)

Actual cost

Cost diagram represents
actual cost

Green

Shown after calculation if uncertainties are defined
and actual cost is available (either entered directly
or percent done for at least one task is defined)

You may use the slider to determine:
•
•

Cost Variance (actual vs. budgeted cost)
Cost with Risks and uncertainties vs. Current schedule (budgeted) cost.

Result cost or
profit

Actual cost or
profit

Use the slider to determine
cost at each period.

Cost variance is updated automatically
when you move the slider

Baseline cost
or profit

